
SELF-PUBLISHING
WHAT YOU SHOULD PROBABLY KNOW BEFORE YOU TAKE THE PLUNGE



Welcome!

 What is publishing?

 What does self-publishing mean?

 Avoiding Scams

 Reading Formats/Distribution Methods

 Helpful Software

 Creating and Preparing Content

 Book Design and Genre

 Formatting for print and digital

 Covers and Cover Art

 Uploading and Organizing Files

 Marketing, Promotion, and Social Media

 *We’ll cover a lot. Follow along with your printout and resources page. There are plenty of links and communities to help 
you through the process once you’re alone with your computer.

 **Join us in September for a more in-depth discussion on book packaging, marketing, and social media.



What is publishing?

 Making a piece of intellectual property available to the general public. 

Writing a blog is publishing. Instragram is publishing. Handing out a ‘zine is 

publishing.

 Trade publishing. Author licenses copyright to larger company, who 

publishes (produces and distributes) book using employees and 

contractors.

 Self-publishing. Author produces and distributes book utilizing services and 

contractors.



What is NOT self-publishing

 Hundreds of companies want to sell you packages to ‘help you’ get your 

book ‘out there’. 

 They whisper promises of riches and dreams fulfilled. They want money (lots 

of it) up front. 

 Their revenue comes from authors buying services and ads, not readers 

buying books. 

 These companies use ambiguous, pretty language about achieving your 

dreams and giving you a voice and empowering you.

 Scams clog up your search for useful self-publishing advice. There are 

more scams than there are resources.



What Happens When You Google 

“Scams”



Help is not a business word



Supporting Your Complaints



Mis-

information 

for Fun and 

Profit



Critical Reading

 Learning to read critically is an important self-publishing skill.

 Scams prey upon emotions using loaded language. Reading critically will 

help you spot these.

 As a business owner, you need to know what you’re signing.

 Successful writers read to sharpen their craft—better writing, better 

storytelling, better understanding of the world.

 Critical readers don’t get scammed. They make educated decisions by 

separating the wheat from the chaff in every bit of advice/instruction they 

are given.



Opinions, Advice, and Who You Can 

Trust

 Everyone has an opinion. Opinions do not make good advice.

 Read critically. Look at who is giving advice, what they gain from ‘selling’ it to 
you, how they have implemented their own instructions, if they have the 
experience to teach it.

 Where else can you find this information/advice? Can you find opposing 
viewpoints? Can you form your own opinion based on the evidence 
presented?

 Is the advice behind a paywall/require something from you to gain access?

 Does the advice require proprietary software/methods that lock you in or can’t 
be found elsewhere?

 Does the advice make promises?

 Does the advice put down other companies/methods and use manipulative 
language?



So you want to be your own 

publisher?

 Awesome! Self-publishing has its rewards. Creating a book is fun and 

satisfying.

 It’s also stressful. Disappearing beta readers, cover art insanity, formatting 

woes, choosing venders and service providers, more formatting woes.

 Self-Publishers wear all the hats: writer, self-editor, cover artist, book 

designer, researcher, formatter, distributor, promoter, marketer, and more

 All the work must be done… by you. Or by someone you pay.

 Each aspect of self-publishing has its own learning curve.

 For better or worse, every decision is yours and yours alone.



The Stigma

 Back in ‘the old days’ the only way to self-publish was to invest tens of 
thousands of dollars, order a print run and store thousands of books in your 
garage.

 Myths persist: only desperate writers self-publish. They are bad and can’t get 
their books ‘really’ published. All self-publishing companies are just scams. Self-
publishers don’t make real books. eBooks aren’t real books. Self-publishers are 
just riding the eBook gold-mine-craze. They aren’t real authors.

 Some readers are hypercritical of errors in self-published books. Vocally 
hypercritical. All books have errors, but most of them go unnoticed/ignored.

 You might run into these myths abroad.



Realities, Monies, and Successes

 There is no horde of readers waiting to buy your first book—no matter who 
publishes that book.

 Writing for money is a long haul.

 Define your own success.

 Mega successes in fiction are never, ever overnight. The media glosses over the 
sweat equity those writers put in before they made the bestseller lists.

 Self-publishers have a lot to learn. It’s a huge time investment to do well. Set 
realistic goals and prepare to learn, work, and fail.

 Set self-actualized goals. You can’t control sales, subscribers, or retweets. Keep 
goals about your work—writing goals, deadlines, blogging regularly, or time set 
aside to work.

 A lone book is a hard sell. Get this one published and write the next book.



Honest Answers to Hard Questions

 What do I want out of this?

 What’s the best way to achieve my goals?

 Have I researched the market to see where my book fits in?

 Is the manuscript ready?

 Do I understand copyright law?

 What can I do myself and what do I need to seek help with?

 Where will I find that help? Can my mother really edit my book? How much should I pay a 
professional editor?

 Am I prepared for 1-star reviews and months with no new sales?

 Am I prepared for success?

 Am I prepared to learn from my mistakes and failures?

 Do I have a business mindset and a business plan?



Great! You’re still here.

 The book industry is not for the faint of heart.

 Your book is art, but selling your book makes it commerce, too.

 Thanks to technology, anyone can publish a book in a variety of formats—

paperbacks (via Print on Demand book machines or offset print runs), 

digital (eBooks), and audiobooks (CD or digital).

 You can build a career or put together a book of childhood stories to pass 

out to your cousins.



Reading (Book) Formats

 Print on Demand Technology—trade paperbacks. Large book binders 

called Espresso Machines create books from digital files one at a time.

 Offset Print Runs—trade paperbacks, mass market paperbacks, 

hardbacks, cook books, other large format or image heavy work.

 Ebook or digital book—text formatted for screens. Phones, tablets, 

dedicated e-readers, computers.

 Audiobooks—text read by narrator. Distributed digitally or stored on audio 

CDs.



Print on Demand Companies

 Createspace. Trade paperbacks, straightforward pricing, good royalties. One free ISBN 
provided for use with the print on demand edition only. An Amazon company.

 Lulu. Lots of options for binding, papers, color, and sizes. You provide ISBN. Privately 
owned.

 IngramSpark. Ingram’s user-friendly print on demand. ISBN provided. An Ingram Industries 
company.

 Lightning Source. Ingram’s business-to-business print on demand. Charges listing fees and 
fee per changes to listing made. You provide ISBN. An Ingram Industries company.

 Blurb. Started out as photo book printer. Now prints all kinds of books and distributes to 
retailers. ISBN provided with download of software. Privately owned.

 Bookbaby. $200 set up cost. Offset print run and print on demand capabilities. A CDBaby
company. Not many favorable reviews.



Pros and Cons of Print On Demand

 Limited options for sizing, paper, and cover (trade paperback)

 Built-in distribution network

 Templates and Style Guides, plus tutorials online

 Formatting forgiveness. You can try until you get it right.

 Higher unit price, less control on final price

 Less upfront cost

 Your garage will not be overrun with books.

 Your book is created when an order is placed.

 PoD companies keep sales records and send you tax forms.



Pros and Cons of Off-Set Print Runs

 Offset printers provide templates but need a perfectly formatted file from you.

 Highest Quality. Specialty book binders like Versa Press create the highest quality books.

 No ISBN, no distribution, no storage, no sales records.

 Lowest per-unit cost.

 Minimum print run 300. Best value at 1,000+.

 Many formats and size options for colors, binding, covers. Hardcover, full color? No problem!

 Your garage will have pallets and pallets of books.

 Seriously. A ton of books in your garage.

 You keep track of sales and tax records.

 Greater pricing flexibility.

 Initial investment of $2,000-$3,000.

 For non-fiction authors with a strong platform and a sales-driven website, this can be the way to go.

 Did I mention the ton of books in your garage?



e-Book Aggregators

 Aggregators convert/upload your eBook file and get it into multiple sales 
channels. They have access to more channels than a lone self-published 
author.

 Smashwords. Broadest distribution in the industry; Meatgrinder (eBook 
converter) is clunky, Meatgrinder must be used for full distribution. Can 
upload an epub but Smashwords does not use this file for their premium 
distribution.

 draft2digital. Fewer distribution channels; greater flexibility in eBook 
conversion. User friendly. Will convert a Word or Writer document into 
eBook or accept an epub.

 Many more options, but these are the two prominent free ones.



Individual eBook Retailers

 Amazon Kindle Direct Publishing (KDP), Amazon.

 NOOK Press, Barnes and Noble.

 Kobo Writing Life, Rakuten (formerly Sony).

 iBooks, Apple.

 Scribd, privately owned.

 Smashwords, privately owned.

 Google Play, Google Inc.

 *Not a comprehensive list. There are markets and retailers all over the 
world, and new markets open all the time.



Audiobooks

 ACX is an Amazon company that allows authors to narrate or hire out a 

narrator for their text, and distributes to Audible and other major sales 

platforms.

 Quality narration is a large time investment. Audio books are hours of 

narration, and the narrator might spend more than three hours preparing 

for every one hour of finished product.



Word Processors and Writing Software

 Microsoft Word. 

 Libre Office/Open Office (open sourced processors). Similar features to 

Word, and can read DOCX files as well as proprietary ODT format. Free.

 Scrivener. Organizes notes, scenes, and chapters of your book. Can 

compile/export novel into other formats, but Scrivener files are not 

compatible with other word processors.

 Calibre. Loads, organizes, and formats eBooks. Free.

 Adobe Digital Editions. Previews epub files. Free.



Organization and Storage

 By the time you’ve written your book, gotten feedback and turned it into a 
manuscript, formatted your PoD book and your eBook (possibly for multiple 
platforms), commissioned two covers, created supplemental copy, and 
whatever else, you’ll have a lot of files.

 Clearly name files and use folders.

 Keep an original file of your manuscript saved for reference and peace of 
mind. Archive often.

 BACK UP YOUR WORK!

 BACK UP OFTEN!

 BACK UP TO SEVERAL PLACES!



The Process (in a kinda logical yet completely 

impractical order)

 Write the manuscript.

 Get feedback and edit manuscript.

 Study other books. Lots of books.

 Write your back cover copy blurb.

 Choose title and ideal book categories.

 Design your book—front and back matter, fonts, layout, other design considerations.

 Format the book for upload/conversion.

 Create/design cover.

 Create accounts at your service providers and create book listings.

 Get proof copy. Make necessary changes. Upload and convert again.

 Create metadata with online retailers/aggregators.

 Click publish.

 Let people know about your book. Make it easy to find and buy.



Fiction or Non-Fiction?

 Two different beasts with different best practices.

 Within fiction, genre can affect layout, design, and promotion choices.

 Non-fiction can require extra pre-press work: lawyers, fact-checkers, 

appropriate disclaimers, securing images, beta testers, trademark notices, 

footnotes, citations, references.



Pre-Press: Self-Editing, Editing, and 

Proofing

 Fix and find as many mistakes as you can, so your helpers can find things 

you don’t see.

 Print it out. Read it aloud. **

 Enlist helper types—fellow book fanatics, readers in your genre, and 

grammar gurus. Exchange manuscripts with a fellow writer in your genre.

 Treat your helper types well. They are helping you because they like you. 

Give them cookies.

 Treat your hired helper types well. You may want to work with them again.

 See handout for more information



Pre-Press: Print Book Design

 Choose 5 books like yours. Study them. Emulate them. Make them your gold standard.

 Create front matter—title page, copyright page, work of fiction declaration, table of 
contents, maps, personae dramatis, pronunciation guides, forwards, introductions, also by 
page, advanced praise, etc.

 *Fiction may not need all of these.

 Create back matter—write, rewrite, and deliberate over acknowledgements, dedication, 
author bio, author’s notes, and excerpts of next book.

 Each page of extras adds to the total cost of the book. Does the reader need it?

 Choose fonts wisely. Serif fonts are recommended. Reading a full length novel is a six to 
ten hour investment for your reader—choose conventional book fonts to make the 
experience pleasurable, accessible, and comfortable.

 Create interior art—color corrected, at the correct resolution.

 Choose how you will separate chapters, scenes, parts.

 Write back cover copy (also known as the blurb). Do not underestimate the time and 
effort and practice and sweat required to get this important piece of marketing ready.



Pre-Press: eBook Design

 Choose 5 eBooks like yours. Study, emulate, make them your gold standard.

 Choose front matter—many eBooks have ‘front matter’ moved to the back. The sooner 
you start your story, the better. Readers who download a sample of a book need enough 
story to help them decide to buy. Readers who download a book expect it to start at 
Chapter 1.

 Extra content does not add extra cost to your eBook, but be mindful of including too 
many bonus features and excerpts of other books at the end of a story—readers feel 
cheated if only half the file is story and the other half is teasers.

 Tweak back cover blurb for optimal reading experience on retailer’s websites (minimal 
direct formatting* and short paragraphs, end with a hook).

 eBooks do not have pages. Or headers. Or footers. Or margins. Or page size. The reading 
device itself takes care of "pages," fonts, font sizing.  Your goal with eBook design is 
flowing pages, maximum readability, and no errors.

 A properly formatted e-Book does not look like a print book. That’s a good thing.



Pre-Press: Choosing/Assessing Your Title

 Your book title is a promise to the reader.

 Different genres have different conventions and expectations.

 Fantasy blends common or supernatural words into new terms and epic concepts

 Wheel of Time, Year of the Demon, Steelheart, Mistborn, Lady of Avalon, Poison Study, The Vampire Diaries

 Romance often references the character or the core conflict

 Rebekah’s Promise, The Duke’s Dilemma, Three Brides No Groom, One Heart to Win, Safe Haven, Levi’s Will, A Plain & Simple Heart, The 
Preacher’s Bride

 Cozy mystery novels play on words or spell out premise

 Death by Chocolate, Corpse Suzette, The Cat Sitter’s Nine Lives, A Dog Gone Murder, Checked Out, Killer Librarian, Butter Safe Than 
Sorry

 Suspense/Thrillers reference catch phrases

 Hope to Die, Hit List, Play Dead, Hold Tight, Game Over, Sleep No More, Cut and Thrust, Bait and Switch, Code Blue, Double Blind

 Series titles hold continuity

 Iron Druid: Hounded, Hexed, Hammered, Trapped, Tricked. Stephanie Plum Series: One for the Money, Two for the Dough, Three To Get 
Deadly, Four To Score. A Song of Fire and Ice: A Game of Thrones, A Clash of Kings, A Storm of Swords.

 Understand what you’re promising readers. ‘A Second Chance for Martha’ sounds like a historical Christian 
romance—not a fast-paced, sexy thriller. With a poorly matched title, the readers you want can’t find you, and the 
readers who incidentally find you won’t be happy.



Pre-Press: Covers and Cover Art

 Making your own cover is a hard thing. Cover artists and designers are professionals who have trained, studied, and spend 
years making great covers.

 Use GIMP or the legacy version of Photoshop, or Word.

 Study, study, study other book covers in your genre. Google "great book covers" and "book cover design" for lists, examples, 
and what not to do. See Resources Page.

 Respect genre. Your cover needs to communicate subgenre and tone with a two-second glance.

 Stock photography is widely available. For print edition, you need a 300 resolution image. Stock will need manipulated to 
remove the stock/slapped on feel. Make sure you buy the rights for commercial use.

 Less is more. Avoid multiple images that compete for attention and distract. Use negative space.

 Choose a strong color palette and focus colors. Use contrast. Go for power.

 Do not create a black cover with red type. Just don’t.

 Strong typography please and thank you. Fonts: limit 2 (3 if 2 are sister fonts), choose one serif and one sans serif. Is title 
legible at thumbnail size?

 On downloading fonts: read the legal/release notes to make sure you can use the font for commercial purposes.

 Two different versions/covers for print on demand and eBook formats. eBook cover sizes can vary, but professional eBooks 
follow a portrait 6"x9" scale, audiobooks are square. eBook cover should be legible and clear from thumbnail size.

 PoD cover dimensions will depend on size and book length (spine width). Use service provider's dimensions and keep design 
elements consistent from front, spine, to back.



Pre-Press: Back Cover Copy

 Writing back cover copy (blurb) is its own skill. It takes time.

 You have 200 words or less. For fiction, give us a character, the character’s problem, who/what 
stands in the way of solving their problem, and what terrible things happen if they fail.

 You don’t have to follow plot points A to B to C. If plot doesn’t condense, try character’s 
emotional journey.

 Tone should match tone of book.

 Don’t think of your blurb as ‘summarizing’ your book, because that’s not possible. Think of it as a 
teaser mini-story, an invitation.

 Don’t talk about the book in third person or make promises. Tell us a story. Show us there’s a story 
inside the book.

 For non-fiction, tell us what to expect (what we’ll learn, why we need it, how this book is unique, 
and how you are qualified/interested)

 The upside of blurbs being so short: easy to get feedback from many readers.



Pre-Press: One-Sentence Pitch

 Some sales channels have space for a short summary of your story.

 Give us character, problem, and what character does about problem in 

one sentence or two short sentences.

 Also called elevator pitch, because the pitch should take less than thirty 

seconds.



Pre-Press: Author Bio

 Keep it short and sweet.

 Use third person.

 Don’t grind axes or justify your book’s existence.

 Do use relevant information and relevant publications.

 Stay professional. Or don’t.

 Study other midlist/new writer’s bios.



Pre-Press: Front and Back Matter

 Acknowledgements, dedications, copyright pages, author’s notes, guides, 

etc.

 Same guidelines apply—short and sweet, professional and heartfelt.

 Look at how other books handle these pages.

 Think about how you read these pages in other books.



Formatting your book for Print on 

Demand, An Overview

 Templates and style guides available. Familiarize yourself with terms and conventions.

 You can either copy and paste your book parts into a template, or assemble your book 
parts and format to match the style guide.

 Do NOT use the space bar, tabs, or hard returns to add white space. Use formatting 
(alignment, margins, first line indent, and breaks).

 Two ways to format text: direct formatting and styles.

 For paragraph, line spacing, font and size, alignment, use styles.

 For italicizing, hyperlinking, and bolding, use direct formatting.

 Change paper size and margins for your book size. Change gutter margins for book 
length. (Page Layout tab > more paper sizes ).

 Insert headers and footers and format them. 



Using Styles in Word Processors

 Styles format sections of text consistently and quickly.

 To apply a style, select the text and choose the style that makes the most sense 
(Normal or Text Body for the main text, Heading 1 and Titles for headings and 
titles).

 Modify the style so it matches the look you want for your book—first line indent 
(or not), font, size, paragraph alignment and spacing.

 Apply a style to every piece of text in your book.

 Styles are important for consistency (a full-length novel is 200+ pages, which is a 
lot to work with) and preserving the format during the upload and conversion 
processes.

 If your Office or Writer file is particularly ‘messy’, scrubbing all styles and 
manually reformatting might be the least frustrating course of action.



Using Styles and Layouts 2.0

 For most of your text, you’ll use Default or Normal (depends on program). 
These styles already exist, so modify them to suit your design.

 To organize text, using Heading 1 for Chapter breaks, and Heading 2 for 
scene breaks.

 To get your book looking bookish, you’ll need to set pages to mirror and 
add gutters (visuals to follow) and change page size. (Page Styles in Libre
Office, Page Layout > Page Setup in Word)

 Your PoD company will have a suggested gutter and minimum margins. 
You might want to do more, you cannot do less.

 If your mirrored view looks reversed on screen, don’t worry about it. (visuals 
to follow).



Using Styles in Word, Some Visuals



More Styling 

in Word



Page Layout in Word



Page Setup in Word



Headers and Footers in Word





Libre Office Styles – Page Styles



More Styles in Libre/Open Office



Even More Styles in Libre Office

 For my novel, I used 7 page styles: left page, right page, chapter start on left page, 

chapter start on right page, back matter, front matter, first page.

 The biggest difference between styles in my book: header and footer—I didn’t want page 

numbers or title on chapter start pages, or on front and back matter.

 Libre Office documents come with Left Page, Right Page, First Page built in. Modify those 

and create new styles built off of them. Use the ‘next style’ feature to automatically switch 

back to another page style for the next page. (Right Page, Left Page, Chapter Start Right 

Page, Left Page)



Page Layout

 In Libre Office, you can 

access page layout by 

Edit > Page Layout or by 

modifying a page style.



From .doc to Book

 Once book document is formatted, upload .doc and cover (pdf) to PoD service provider.

 Createspace checks document.

 If there’s a problem with file, Createspace will tell you what it is. Fix it and upload again.

 Once file is accepted, Createspace builds a page-by-page preview.

 Order print copy of proof and do something else while you wait for your proof copy to 
arrive.

 Review proof copy. Spent time with it. Make changes to your file and upload again.

 Review digital preview again.

 Order another proof copy if substantial changes were made.

 Set price, pick channels, finalize metadata.

 Click publish.

 Order copies to hand-sell and arrange dramatically on your bookshelf.



eBook Publishing in 8 Over-Simplified 

Steps

 Clean up your document

 Use simple styles for headings, indents, and spacing

 Upload or Open into chosen program/website

 Preview conversion files

 Attach cover

 Edit Metadata

 Upload/Approve

 Click Publish



eBook Formatting

 Different service providers have different upload/conversion standards, but the process is similar to PoD formatting: use styles to format headings 
and text.

 Smashwords has a strict style guide and recommends a file scrub called the nuclear method. If you want Smashwords’ full distribution (and you do), 
you must adhere to their style guide, and the file created by their software is proprietary to Smashwords.

 Draft2Digital uploads your Word or Writer document, finds chapters, and auto generates files from your POD-formatted book. You can preview the 
epub using Adobe Digital Editions to see if further adjustments are needed.

 Calibre can open Office and Writer files for conversion to multiple eBook formats.

 Fiction without images or bells and whistles can be formatted easily with minimal styling.

 If you have inconsistent formatting and styles within your document, eBook formatting can be a nightmare. Going nuclear might be the least 
frustrating option. (Copy entire document, paste in to blank notepad, copy, and paste into new Word doc. All formatting must be reapplied.)

 Special characters like tabs, < > / and smart quotes can cause errors. eBooks are essentially coded as HTML, so avoid them. 

 Use find & replace to purge your document of problematic symbols (link in Resources)

 Use Show All Characters (or Show Formatting) to see all hard returns, spaces, and tabs otherwise hidden.

 Use Insert > Bookmark command to add easy jump-to navigations. Start for the beginning, TOC for Table of Contents.

 eBook devices use native fonts, sizing and pagination. Worry more about reader experience across multiple devices than making your eBook look 
just like your print book. It won’t.

 Images in eBooks can be frustrating.



Metadata, AKA Your Card Catalog 

Entry

 Information about your book: publication/release date, author and 

contributors, series and compendium information, subtitles, keywords, ISBN, 

short description, long description, edition, language, categories, age 

range, adult content

 eBook aggregators and PoD printers compile metadata in a form and 

‘package’ it for you. If you use software like Calibre, you will have to input 

metadata when the eBook files are converted/created. Different 

aggregators might have different metadata requirements/entries.



Shelves in the Great Internet Bookstore

 Books are divided into BISAC categories (Book Industry Standards and Communications)

 Choose wisely. This is one way readers find you. What categories do books like yours fall into?

 Some aggregators allow more than one category for your book. Start with the closest category 
first, then work your way out.

 Choose the most specific categories possible. Fiction>Fantasy>Modern Fantasy puts your book 
into Fiction, Fiction>Fantasy and Fiction>Fantasy>Modern Fantasy. “Fiction” has billions of books 
in it. Your book will get ‘lost’ unless you get specific.

 Keywords and tags help further clarify your story’s unique appeal.

 Choose keywords/tags

 Specific tags like a unique setting (colonial America, Bronze Age Europe), story type (coming of age, 
dystopian, space travel), character types (single father, guardian angel, cat detective)

 Avoid self-evident tags (fiction, literature, fantasy, non-fiction, or book title)

 You can update keywords/tags as you better learn the market. If you’re overwhelmed, come back to this 
later.



From Desktop to Sales Page

 Create or choose primary email account for all your writer-stuff.

 Create accounts with companies as needed. Write down account names and 
passwords, store in a safe and sacred location.

 Read the fine print before you click accept.

 Most sites are user-friendly and can guide you through book creation process. 
Your biggest hang-ups might be file conversion and formatting, or choosing 
design, metadata and sales options.

 Google is your friend when you don’t understand options or want to read other 
self-publishers’ experiences. The more specific your question, the better your 
results. (Not ‘how do I self-publish’ but ‘createspace margin error’)

 Some sales programs restrict or demand exclusivity. There’s no right or wrong, 
only business decisions and educated choices.



So Many Choices

 From ‘start new book’ to ‘publish’, you will make a lot of choices: price, 
distribution, my ISBN or theirs, size and cover options, categories, release dates, 
programs, and more.

 You will have to make these decisions with each service provider you utilize.

 Slow down. Learn about each choice before you click yes or no. Understand 
what you’re agreeing to.

 These options change all the time—Amazon has changed how Kindle Select 
works at least three times in the past two years and rolled out several more 
promotional programs. Use current research.

 Once your book looks and acts like a book, these options are not ‘right or 
wrong.’ They are hard choices to make because it’s based on what you want 
for your book and how you plan to market.



Published, Now What?

 CONGRATULATIONS! YOU DID IT, HURRAY!

 Stop panicking.

 You’re going to find a mistake, a typo, or something weird with a file the day your book 

goes live. Just fix it or ignore it.

 Stop looking at your book listing.

 Go write your next book.

 Stop looking at your sales records.

 Get back to writing your next book.

 Mention to your friends and family that you wrote a book.

 Seriously, get back to writing your next book.



Promotion and Marketing

 Think long and hard about how you find books you love.

 I’ve bought books I heard about on Twitter, Tumblr, Facebook, and author’s blogs. The story sounded like something I wanted 
to read.

 But I’ve never, ever bought a book because someone spammed me, sent me a private message, or tweeted BUY MAH 
BOOK OMG!!!!!1!

 Social media is powerful, but sell the story—not the fact you wrote a book.

 You can politely ask for reviews at the back of your eBook. Put links to review page.

 Your greatest promotional tool is your next book.

 Giving your eBook away for free can get you lots of downloads, not necessarily lots of reads.

 A lone book is a hard sell. Write your next book.

 Put your first chapter up on your website with links to buy.

 To promote online, be awesome online. Study the masters (The Oatmeal, Amanda Palmer, Neil Gaiman, George Takei, the 
Bloggess) and learn how they inspire their communities.

 Note: I just said inspire their communities, not ‘engage with followers’ or ‘add subscribers’. Treat people like people. There is 
no such thing as magic in social media.

 Be confident in the work you’ve done. Confident people don’t yell. They say it once and get back to work.



Selling Your Story, Branding Yourself

 Forget SEOs, USPs, and verified clicks.

 Why is your book important? (And not just because you wrote it)

 What’s unique about it?

 For fiction, think about other authors and what you expect from their stories. 
This is tone, types of characters, types of stories, unique perspectives that bleed 
into their fiction, storytelling style, and more.

 Identify these for your book.

 For non-fiction, look at the other books in you category already out there. What 
new perspective or information does your book offer?

 How can you present these to the world at large? How can you weave these 
elements into your book packaging (cover and blurb)?

 How can you share these unique bits as teasers for your book?



Blogging is Not All That Scary

 Choose one of many platforms: Wordpress.org, Wordpress.com, Blogger (blogspot.com), 
tumblr.com, Google Plus (plus.google.com), Weebly.com

 Each platform has strengths and weaknesses (ease of use, sharing capabilities, 
communities, design and customization). Pick your poison.

 Sign up. Create a post. Click publish.

 The more you do it, the better you will get at blogging.

 Don’t overextend or overcommit. Post when you have something to talk about.

 Post free short stories, recipes, or funny anecdotes.

 Share fun stuff.

 Post when you have a new release with links.

 Create pages (permalinked posts) about your releases with sample chapters and teasers.

 Do as I say, not as I do: there’s a lot of advice out there on effective blogging. I don’t do 
it ‘right’ or ‘well,’ but I do enjoy it.



Newsletters: Maybe a little Scary

 Different services offer newsletter coordination (Mailchimp is free for up to 2,000 
subscribers)

 Set up account, choose name of newsletter, what your signup form will look 
like, and write the newsletter

 General Do’s and Don’t’s:

 Keep it short and organized

 At least once a quarter, no more than once a month

 Offer something free or special

 Announce your new releases, put in links

 Announce your book events/sales/guest appearances

 Do not sign up others (this violates CAN-SPAM laws). Have them opt in themselves.



Podcasts, Youtube, and Vines?

 There’s a lot of social media out there. Pick the ones you want to do, the ones 
you can do well, and leave the rest behind.

 Try it out as a reader first, then test the waters.

 Social media can be a black hole—soaking up all the time you give it, and 
demanding more. Have a plan.

 Adage: 30% of marketing works, but no one knows which 30%.

 Social media can sell books. CAN. Not will. No one controls what goes viral and 
what gets buried.

 Some topics lend themselves well to different formats. Workout instructors and 
computer technicians can find audiences at Youtube, because people want 
how-to videos. If you see a good road, take it. Don’t force it if you can’t.



A Million Paths

 There’s many different ways to:

 Write the book

 Make the book look like a book

 Make the book

 Package the book

 Sell the book

 Promote the book

 Share the book

 Read the book

 Every author’s journey is different.

 Every book’s journey is different.



Go be dangerous.

 You now know just enough about self-publishing to be a danger to yourself and your 
community. Wield that power wisely.

 Being your own publisher is a big learning experience. 

 Failure is the best way to learn. Make opportunities to fail without an audience…

 Share your work with trusted friends.

 Play around with formatting your files before you click publish.

 View your eBook files from several devices.

 Get editorial feedback from many sources.

 Make a dozen mockup covers before you settle on one and look at them from different 
screens over the course of a month.

 Practice writing blog posts and see how your design works on mobile and desktop before 
you tell people about your blog.



Thanks for Reading!

 Check out peowrimos.wordpress.com for more information on writing and 

how to get involved in our local writer’s group.

 Seminar created by Barb (blrude@gmail.com), barbrude.wordpress.com

 This information is current as of 6/15.
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